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Chapter 1 - Introduction

Corpse (Course Planning and Setting software) is a computer-based facility
which can assist in the development of quality orienteering courses.

Corpse uses a computer image of the orienteering map to enable courses to be
developed interactively on a computer. These map images can be sourced from
scanning an existing map or exporting a map image out of OCAD.

All courses for an event are plotted directly “onto” the map image. This enables
the course planner to quickly see the interaction between courses and the
suitability of sharing controls between courses. It also enables the course
planner to quickly try “what if” scenarios, e.g. what is the course length if a
control is added to a course or moved to another location. This is an invaluable
teaching aid when demonstrating the nuances of course setting to the new
course setter.

Corpse facilitates change by rippling the change through all affected courses.

For example, a control’'s number or description can be changed and all control
description sheets are automatically updated.

Disclaimer

Corpse is a tool only. Good orienteering courses cannot be developed from the
armchair; course setters must visit control sites to confirm their suitability. While
Corpse can aid in the course planning and printing processes, it cannot
guarantee that the right control is put in the right place. Furthermore, Corpse
does not have any intuitive powers; it cannot identify what feature the control
circle is centred on and cannot prevent you from describing a watercourse as a
termite mound in the control descriptions sheets.

Manual Conventions

The following typographical conventions are used throughout this manual:

text Indicates a menu or speed button on the screen.

text B text  Indicates a menu hierarchy.

text Reference to another part of this manual.

<key> Indicates a key on the keyboard, e.g. <Alt>.

+ Two or more concurrent actions, e.g. <CtrI>+<End>+<Del>.
<click> Click the designhated mouse button.
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Licence

Corpse is available in two forms:

» Corpse - Demonstration
This version is capable of loading any file created by Corpse. All facilities
such as add controls, move controls, change course descriptions, add courses

and preview maps and control descriptions are available. Files can be saved.

Courses which have more than 5 controls (including the start and finish) can
not be created or printed.

» Corpse - Licenced

Once Corpse is licenced, the 5 control restriction is lifted.
Corpse is registered by providing a valid Product Key in the form
Fkkkk_fkkkk kkkkk_kkkkk ek gt installation time. The key is provided following
payment and should be stored in a safe place.

Purchase of Corpse can be arranged through:

Corpse Home Page: http://www.0o-ware.com; or

the author:
R.A.Saye,
5 Hooley Place,
KAMBAH ACT 2902
Australia
Ph: (02) 6231 9661.
email: rex.saye@actewagl.net.au

Licencing of Corpse is to an individual. Corporate or club licencing is available
upon application to the address above.
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Chapter 2 - Overview

Features

Corpse offers the following features:

& Plan courses directly onto the map. Add a control with the click of the mouse.
Drag and drop controls into new locations. See which other courses use this
control.

& The description for any control need only be entered once. This description
will then appear in any control description for any course that makes use of
that control.

@ Control description sheets for courses can be printed in English or using IOF
symbols.

& Course lengths are automatically calculated.
& Last leg lengths are automatically calculated.

@ Control description sheets can be printed in various formats, e.g. multiple
copies per page of individual descriptions for guillotining, multiple descriptions
per page for distribution with event information packages or print descriptions
straight onto the map.

@ Control identification codes are checked for duplication. A cross reference of
all controls used in an event and the courses on which those controls are used
is available.

@ Check control loadings, leg loadings, whether legs are being run in both
directions, etc.

@ Master maps and course maps can be printed. Leg lines and control circles
can be broken so as not to hide important map features. Leg lines may be
bent if required. Additional features such as logos, crossing points, water
drops, out of bounds areas and forbidden routes can be printed at the same
time.

@ Courses, additional features and control descriptions can be inserted into the

EPS file created by OCAD. Courses will then be printed at the same time as
the map. Alternatively, the same Corpse data can be added to the purple
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colour separation and printed as an overlay onto existing maps.

You can produce OCAD quality maps without OCAD. Corpse cannot change
the map file or OCAD file. OCAD's *.OCD files need never leave your
protection.

Courses can be planned on a map of one scale (e.g. 1:15000) and then simply
moved to a map of a different scale (e.g. 1:10000).

Courses with multiple loops can be created.

Course climbs can be automatically calculated.

What Is New In Version 47?

Corpse Version 4 has:

Timed backup of CPE file.
Ten level undo command.

Approach/departure arrows are displayed around controls to aid in the
placement of course sequence numbers on maps.

Control sequence numbers can be positioned in different places on different
maps for the same control.

Control identifiers or sequence numbers can be displayed on the master map.

A new "cartography mode" to allow maps to be marked with out of bounds
areas, forbidden routes, boundaries, water drops, etc.

Preferences such as control circle diameter, line thickness, fonts, etc. are now
saved with the CPE file enabling the more affective sharing of files.

Two symbols can be entered into column H.
Funnel Finish has been added.

IOF symbols have been revamped. The user can even select the thickness
of pen used to draw these symbols.

The number of courses is now unlimited.
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» The number of "holes" has been increased to 150.
» Finish circles can be broken in the same way as normal control circles.

» Corpse can leave a gap in the control circle to prevent "ink blobbing" in the
plotting process. The user can now select the size of the gap.

» Plotter registration points are now general registration points (e.g. for EPS
printing). They can now also be deleted.

» English descriptions generated by Corpse can be long (e.g. north eastern) or
short (e.g. NE).

» Controls can be used more than once on a course. This is intended mainly
for the design of multi-loop courses with a single map exchange.

» The information displayed by XRef can be copied to the clipboard.

* The “Tailor Map” function now allows for the map to be cropped to a smaller
size. This will help Corpse to run faster. The process which reduces map
colours to 256 has been enhanced to give a better colour representation of the
map.

» Titles can be optionally printed or plotted on maps to facilitate identification
of different courses.

» EPS output can be stretched to facilitate overprinting courses on preprinted
maps.

» EPS output does not use fonts to render text. This removes the need for a
font to exist on the computer equipment of the print shop.

* Right <click>ing over the course tabs now selects the new course before
displaying the Events menu.

» Controls which are not on the currently active course can be hidden providing
an uncluttered view in areas with many control sites.

What Is New In Version 5?

Corpse Version 5 has:

* The number of D symbols has been extended to include all IOF defined
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symbols. D symbol selectors are now grouped in blue, green, brown and
black representing their orienteering classifications.

A new window has been added to permit you to view a course leg as the
orienteer would see it. The map is rotated so that the leg line goes from the
bottom to the top of your screen (south to north).

A quick entry facility has been added. You can now establish courses using
a spreadsheet type entry. Basic information such as course name, number
of competitors and classes can be edited.

View control options have been added to control the display of cartography,
control identifiers, and screen centring if a selected control is not visible.

New Course EPS files can be produced without the need for a template file
such as the "purple.EPS" file.

You can now create and maintain a personalised list of control identifiers
which you consider to be unacceptable, for example 161 and 191. Corpse will
warn you if you attempt to use any of these control identifiers.

The current course length and current leg length have been added to the
status bar to facilitate course planning in "full map mode".

When planning courses, the use of <Ctrl>+<up arrow>, <CtrI>+<down arrow>
moves the position of the currently selected control up or down one position
within the current course. This allows you to add a new control and move it
to its correct sequence position while operating in "full map mode".

When planning courses, the use of <Shift>+<up arrow>, <Shift>+<down
arrow>, <Shift>+<left arrow> and <Shift>+<right arrow> moves the position
of the currently selected control one pixel at a time on the map in the direction
selected by the arrow.

When planning courses, the use of <CtrI>+<Delete> deletes the currently
selected control.

Corpse can now input the "map.EPS" file generated by OCAD. You can now
select any amount of detail you wish. | have loaded maps at 900 dpi. You no
longer have to use the BMP file created by OCAD. Using the EPS file will
ensure that you are not course planning on a BMP file which represents one
area of the map and adding courses to EPS files which represent another area
of the map.
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Corpse can now preview EPS files which have been produced by OCAD or
Corpse, and can overlay "course.EPS" files produced by Corpse onto a
template EPS map.

Multi-loop courses can be planned as a single course. The multi-loop course
can be split into its component loops automatically.

Relay courses can be planned as a single course. For the purposes of the
relay, any control on a course can have up to 4 alternatives. The composite
relay course can be automatically split into the various separate relay courses.

A concise option has been added to the XRef facility. The information
presented in the detailed XRef can also be tailored to suit your individual
needs.

Ski-O, Bike-O control format (1-32, 2-33) numbering on maps has been
added.

Courses can now have a pre-start distance (the distance from the map
collection point to the start triangle).

Check marks can now be added to the master control list. This is useful when
ticking off controls which have been field checked or identifying controls which
need special attention, etc.

Corpse data can now be exported to a text file or mailed directly.

What Is New In Version 6?

Corpse Version 6 has:

Corpse has been updated to comply with the IOF 2004 Standard. Corpse 6
can read files created by earlier versions of Corpse but cannot write files for
use with earlier versions. This has arisen because of the fundamental
changes made by the IOF 2004 Standard.

Course information can be exported (in the XML format) for use with other
software packages such as Sport Ident.

The map display routines have been improved giving a much faster response
time when scrolling maps.

Each leg can now have a climb associated with it. These are automatically
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totalled to give an overall climb for the course. Climbs for legs occurring in
multiple courses need only be entered once.

» A"display cross hairs" option has been added to control circles. This aids in
the accurate positioning of control circles on map features.

* Map markup (printing of control descriptions on maps) has been enhanced.
Control descriptions can be printed on the map fronts and/or backs.

» Overlay printing has been added. This enables the printing of courses on
existing maps with your own printer.

* An Event Footer has been added. This can be used for general comments
such as "safety bearings" and "course closure times".

» Corpse can now add colour text and colour pictures onto maps e.g. Sponsor's
logos.

» Blank borders can be added to the OCAD EPS file to provide off-map areas
to print control description sheets, logos, etc.

» Many other improvements such as popup menus, real-time generation of text
descriptions, user entered course length, control selector, etc.

» Direct support for plotter technology has been dropped. Plotter technology is

generally being (or been) phased out. Drivers for XP are either unavailable or
poor quality.

Design Philosophy

Corpse uses an image of the orienteering map to define a working area in which
to plan the orienteering course. While the extents (length and breadth) of the
map establish the bounds of the course(s) Corpse does not alter the map in any
way. Instead, control circles and leg lines are drawn on a “film” covering the
map. Corpse also introduces the concept of “holes” in the “film”. If a leg line
crosses a “hole” then the line disappears allowing the map feature in the “hole”
to be seen.

As Corpse uses the map to define the limits of the course area, then if no map
exists then there can be no courses. Furthermore, as the map is under the
drawing film then the map can be replaced by any other map or scanned image.
Corpse has no way of knowing that the image is a map let alone the right map.
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Corpse maintains a “master control list” which contains the control descriptions
for all controls for a particular event. Any controls added to a course are
automatically added to the master list and are then available for use on any other
courses. As the controls in the master list are shared, any changes made to a
control (position or features) are applied to all instances in all courses. While
controls are added automatically to the master list when adding them to courses,
they can only be removed from the event by actually deleting them from the
master list. A check is first made to ensure the control is not included on any of
the courses before it is removed.

Corpse creates a single file (*.CPE) for an event. This file contains the
description of the controls, the controls in courses and their X,Y coordinates on
the drawing film. Sharing of Corpse information therefore, is achieved by
sharing this CPE file. The CPE file is typically very small and suitable for email.

The controller/setter relationship can be effectively established by initially

providing both parties with a copy of the map image. The CPE file can then be
exchanged as often as desired through the life of the course setting process.

Design Parameters

Maximum number of courses - Unlimited

Maximum number controls for an event - 255
Maximum number controls per course - 50

Maximum number of holes - 150

Maximum number of cartographic objects - Unlimited

Corpse Files

System Files
Corpse.exe Corpse program
Corpse.hlp Help file
Corpse.cnt Help file
Corpse.pch Punch patterns as defined by the user

Temporary Files

Corpse.tmp Transient copy of current Corpse data

Corpse.bck Timed backup of last/current Corpse data file

Corpse.00? Files created to support the Undo feature
Input files

*.bmp Map images in Windows bmp format

*.eps Map images in Postscript format
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Output files

*.cpe Corpse data files containing course information

“course name”.eps Map images with courses in Postscript format

“course name”.bmp Course templates in Windows bmp format

*.bmp Copies of bmp map images mentioned above (usually
with lower colour definition or with lower DPI) in
Windows bmp format

*xml A self documenting XML file containing much of the
data used by Corpse for the event

System Requirements

Corpse was developed with Delphi 4 under Windows 98 SE, XP.

The development machine was a Celeron 2.4 GHz with 512mb of real memory,
a 17 inch display set at 1024x768. Performance and responsiveness were very
good. Printing was tested on a Canon S600 and Xerox Phaser 7700 laser
printer.

While Corpse will run on a display set at 640x480, much of the capability of
Corpse will be unavailable as buttons do not fit on the screen.

A recommended minimum configuration is a Pentium 133 with 128mb of real
memory.

Windows 98 or better is essential.

Colour printers provide better results when printing maps otherwise a black only
graphics capable printer is fine.
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Chapter 3 - Getting Started

The information in this section is intended to provide a simple process for using
Corpse to plan an orienteering event and print control description sheets. There
are many more features available in Corpse which can be explored after
mastering the basic process.

House Keeping

» Create an Event Folder

Using Windows, create a folder where all files relating to this orienteering
event can be stored. While having more than one event in a folder is possible
it should be avoided as Corpse creates files with default names and may
therefore overwrite or intermingle files with other event files. (For further
information, refer to the production of EPS files.)

» Acquire an Event Map

Acquire a map file by scanning a map or exporting a BMP file or an EPS file
from OCAD. Save this file in the event folder.

A BMP file with a resolution of 200 dpi and 64000 colours provides adequate
detail.

It is better to use an EPSfile if it is available. EPS files provide better quality
maps and you can adjust the display quality with Corpse without having to get
another BMP file from OCAD.

» Acquire an Event EPS File

This step is only absolutely necessary if the intention is to print high quality
course maps for an orienteering event.

If your event map is an EPS file, this step can probably be skipped. If your
event map is a BMP file from OCAD then it is best to acquire the EPS file at
the same time as you acquire the BMP file so that you are certain that the
EPS file is an exact replica of the event map BMP file. Save this file in the
event folder.
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» Start Corpse

Start Corpse by <click>ing on the appropriate Windows icon.

Create An Event File

The event file contains the control descriptions, courses and other parameters
for an orienteering event. The name of these filesis “filename.CPE”. A separate
file is required for each event.

A new event file is created by selecting File B New on the menu bar. The default
name of the file is set to “Untitled. CPE”. Use the File b Save As option to save
the event file immediately; this has the effect of setting the default folder for all
other files.

An existing file can be opened using File » Open on the menu bar or by selecting
a file from the list of up to five files displayed on the File menu on the menu bar.

Corpse checks the structure of the event file when it opens the file. If problems
occur then, the file is reported as “corrupt”. Corpse maintains upward
compatibility in that Corpse Version 1 files can be read by Corpse Version 2, etc.
The reverse however is not possible.

Name the Event

The “event name” is displayed at the top of each control sheet listing. Any
combination of printable characters can be entered. Maximum length is 100
characters. The default is “Untitled”.

The text is wrapped to fit into the available space. If the text contains a "|" then
the text is broken and a new line is commenced.

The event name is entered using Event B Event Name on the menu bar.

Load A Map

A map is required to make use of the Corpse system. As it provides a surface
on which to place the controls, many of the tools are unavailable until a map is
loaded.

Large map files will slow down the operation of Corpse. However, using maps
which are at a low DPI can mean that features on the map may not be visible.
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The map is loaded using Map # Load Map on the menu bar.

BMP Map Files

Some BMP files do not have the DPI information recorded in the file. If the DPI
information cannot be found in the file by Corpse, a dialog box will appear so that
it can be entered manually.

EPS Map Files

EPS map files should be used whenever possible. The quality and size of the
resulting map is controlled by you at the time of loading with the following dialog.

F¥ Load EPS File i =] ]

—Map Detail
File Mame: C:\Program Files\Corpze Bgldsmap. eps
Creatar: OCAD £.00
Colours: Cyan Magenta Yellow Black
Size: 144.6 mm % 111.8 mm

—Map Render Option:
Calours: |1 E hit [E5.536 colours) j

DFl: 200

Memory Reqd: 1.91 mb

DOkay | Cancel

To change the quality, simply reload the EPS file. You can also use the same
EPS file in the printing process.

It is recommended that you start with settings of 200 DPI and 16 bit colour and
experiment with other settings.

Warning The map requires the use of the physical memory of the computer
(RAM). If the map storage requirement is larger than the available RAM then
Corpse will run slowly and probably fail. It may be necessary to close other
programs to maximise the availability of your computer’'s RAM for Corpse.
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Set Map Scale

The map's scale influences the calculation of course and leg lengths.

Scale This is the orienteering map scale, common values being 1:10,000
and 1:15,000. A drop down list of typical values is provided.
However, any numeric value can be entered.

The scale is set using Map B Scale from the menu bar. The default is 1:15,000.

Hint - Create a two control course on the map's scale bar and compare the
length of the scale bar with the course length calculated by Corpse.

Customise View

The map is the main interface to the Corpse package.

When the map is first loaded, it is displayed at full scale. Using the zoom tools,
adjust the magnification to provide the largest view while still maintaining
sufficient detail to allow the placement of controls. The whole screen can be

dedicated to the map display by selecting the map mode with the il button.

The section of the map which is displayed is controlled by using the slider bars
at the right and at the bottom of the map display.

Create Courses

The procedure outlined here requires that the control description sheet be visible
on the screen. Ensure that either the_'I button or theil button is down.

Repeat the following steps for each course:

+ Create a new course with the desired name using Event b New.

* With the QI button down, position the cursor over the selected control site
and <click> to add a control. Controls not already on this course are also
displayed on the map. <Click>ing on an existing control will mean that it is
“shared” and not “duplicated”, e.g. the start and finish.

» Enter the control description using procedures explained at Course
Descriptions in this manual.
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» Set any other information required for this course (class, course climb,
competitors, etc.) using the options on the Event menu.

» Drag the controls in the control list to the required position in the list to create
the desired course. Refer to Menu Bar, Control Descriptions Panel in this
manual for more information.

Note! Tools are available to remove controls from courses and reposition
controls. Refer to Screen Components, Map Tools in this manual.

Multi-Loop Courses

A multi-loop course is one which requires the competitor to visit a map exchange
one or more times to obtain a map and control descriptions which describes the
next segment of the course.

Corpse enables you to plan the course as a single course using map exchange
controls where required. (See Create Courses). Because you are re-using
controls you must ensure that the control protection option is turned off. Thisis
done through File B Settings # Controls.

The single, multi-loop course can be split into its individual loops prior to printing
of maps or control descriptions. Thisis achieved with Event # Separate Loops.

During the split process, the first sequence number of each loop is altered so that
the numbers are identical to those of the single course. The course being split
is also replaced by one of its component loops. To retain a copy of the full
course copy it to another course prior to splitting it. This is achieved with Event
» Copy Course.

When a multi-loop course is split, new course names are generated (refer to
Relays). If errors are encountered, the separation process will be abandoned.

Butterfly Courses

A butterfly course is similar to a multi-loop course described above. The only
difference is that the re-visited control is not a map exchange control.

A butterfly course is planned like a standard course, re-using controls as
required. (See Create Courses). Because you are re-using controls you must
ensure that the control protection option is turned off. This is done through File
# Settings b Controls.
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To prevent Corpse from placing the control sequence numbers of the re-visited
control sites on top of each other on the map, you must use the “local control
sites” setting for this course. This is done through Event # Local Control Sites.
You will now be able to position the various sequence numbers for the re-visited
controls in your preferred positions. Refer to Course Descriptions, Setting IOF
Descriptions, Column A - Control Number.

Relays

A relay is a course where team competitors visit one control of a cluster of
controls as opposed to all competitors visiting the same control. Control clusters
are set up so that the courses are ostensibly the same (in distance, climb and
complexity) but are not identical.

Creating Relay Courses

Relays can be planned by allocating alternative controls on a course. If, for
example, an alternate control is specified at control 2 then two relay courses will
be available. These are: Start, 1, 2, 3...., and Start, 1, 2a, 3....

To develop a relay follow the following steps:

» Develop a course in the normal way. (See Create Courses). The controls
defined at this time are called "primary controls". Primary controls are the
ones which appear in the control descriptions at the side of the screen. This
is called the "primary course".

» Select a control on the primary course for which you wish to define an
alternative control.

* With the QI tool from the map tools selected, click on a new control site with
the <Ctrl> button down. Corpse will now display the original course and the
alternative path. If a control description sheet is displayed, it will only show
details for the primary course.

» Controls can be deleted from a relay by clicking over the control to be deleted

with the il tool from the map tools selected. If the control is an alternative
control, it will be deleted and the map updated. If the control is a primary
control, it will be deleted and replaced by one of the alternative controls (the
control descriptions sheet will also be updated). The map will then be
updated.

» Details of the various relay courses can be viewed using XRef. Alternatively,
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relays can be "exploded" into the individual courses. Once a relay has been
"exploded" it cannot be "unexploded”. However, the "explode" can be undone

with the El button.

» Print the courses or control description sheets as required. If component
courses and control description sheets for relays are required then the relay
must be "exploded" first. Otherwise, only the "primary" course will be printed.
Refer to Screen Components, Event Menu, Explode, Relays.

Course Setting Limitations

The relay is a standard course with alternative courses. You can work on the
standard course (primary course) in the normal way e.g. add controls, delete
controls, move controls on the map, etc.

Alternative courses are added to the standard course by defining alternatives for
the primary controls on the standard course. If you reposition the primary control
in the control sequence, the alternative controls are also repositioned in

the control sequence.

To modify an alternative control you will need to gain access to it; usually
through the master list. It is only there where you may enter the description,
break the control circle, or move the position of the control on the map.

Relay Course Names
The following rules apply during the "explode" process:

» The names of the "exploded" courses will be based on the original course
name with "-01", "-02", ... added. The original course name may be truncated
if the resulting name exceeds 10 characters. If the resulting names are not
unique, the "explode" process will be terminated with an error message.

* If the original course uses "local control sites” then, these positions will be
used wherever possible when placing the control identifier. Generally, for
alternative controls, the control identifier will be positioned as specified in the
master list.

Control Identification Numbers

The master control list contains all of the controls used in the event.
Identification numbers of controls can best be set using the master control list.
Select the first control in the list to have an identification number (usually not the
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start or finish) and enter the first number. Use the tool to allocate sequential
numbers to all controls in the master list. To establish different number runs,
perform this procedure by selecting a control anywhere in the list. Controls
above the selected control will not be renumbered.

Control numbers on the ground can be clustered by ordering the master control
list so that controls which are near each other on the ground are near each other
in the list. Auto-numbering will result in adjacent controls having consecutive
numbers.

Checking Control Utilisation

Use the XRef facility located on menu bar to check information such as:
» duplication of control identifiers,

» controls that have not been provided with identifiers,

» the number of controls required,

» control loadings (especially for water drops),

+ distance to the first water station on courses,

» course leg lengths, and

» leg utilisation.

Print Course Descriptions

All printing is carried out using the Print option, available on the tool bar. A
Preview option has been provided to enable the output to be reviewed prior to
printing. It is highly recommended that a preview is always done before a print.
Select the appropriate print arrangement. Typically this would be:

One per page when a single copy is required, e.g. master control list.

Many Courses per page for field checking of courses or preparation of material
for event kits.

Many Copies per page for producing multiple copies of control description
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sheets for the day of the event.

Select landscape or portrait page layout. This along with font and print margins
can affect the number of control description sheets which can be printed on each

page.

Change Scale

When preparing maps for an event, it is often necessary to produce course maps
at 1:10,000 and 1:15,000. This is easily achieved by doing all of the control
positioning and control descriptions at say the 1:15,000 scale. When all work has
been completed for this scale then create a 1:10,000 scale file by:

» Save your current CPE file, e.g. “file 15000.cpe”.
» Save your current CPE file with a different name, e.g. “file 10000.cpe”.

+ Use the stretch facility (accessed through Map B Stretch) to change the scale
from 1:15,000 to 1:10,000.

+ Load the new map file (which would be a 1:10,000 map) through Map ¥ Load
Map.

 Identify a control which has a map position which can be accurately located
e.g. on atrack crossing. Use the procedure outlined at Screen Components,
Tool Bar, Map Tools, Select, Position All Controls in this manual to relocate
all controls to their correct positions.

» Save your current CPE file, i.e. “file 10000.cpe”.
Warning The control circles will cover different areas on the map at different

scales. Check your control descriptions and circle breaks to make sure that they
are still accurate.
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Chapter 4 - Settings

Use the File B Settings option to set options that are in effect each time you start
Corpse. These settings apply only to your computer. The following options are
available.

System

» Colour Match On Load

This option causes Corpse to internally change the colour depth of the map
if the map has more colours than the screen can display.

Systems such as OCAD and some scanners produce 24bit bit maps
representing 16.7 million colours. If your screen is not set to display this
many colours then the computer spends significant time translating the map
from the large colour set to the smaller set.

Use Help B System Parameters to determine the colour setting for your
screen.

Warning! The affect of using colour matching is that Corpse will operate
faster. The down side is that the initial load process for a map can be quite
lengthy. It is better to create a new BMP file using Map # Tailor Map. If your
map file is an EPS file then the initial load process is not affected

» Timed Backups
Setting this option will cause Corpse to periodically create a full copy of your
CPE file. The frequency at which this backup is taken is controlled by
selecting a value for "minutes” from 1 to 1000. Backups are not taken if there
have been no changes since the last backup or if Corpse is not licenced.

If timed backups have been selected, a clock is displayed on the bar at the
top of the map panel.

» Punch Size
Corpse can support punches which have a size of 3x3 up to 9x9 pins. Setting

this option will cause Corpse to create new punches with the number of pins
you have selected.
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» EPS Interpreter

Corpse can read EPS map files produced by OCAD. The interpretation of
these EPS files has been optimised to shorten the reading process. If
problems are experienced with reading EPS files, uncheck this option.

» Control Number Window
This parameter controls the size of the flyout map segment which is used for
positioning the control identifier on the map. A segment size ranging from 10
to 50 millimetres of the map can be selected.

» Course Tabs

This parameter controls the number of characters from the course names
which are displayed on the course tabs.

Characters from the beginning or the end of the course names may be
selected. Setting the number of characters to 0 will mean that the whole
name is selected. Selecting a small number of characters will mean that
more course tabs will fit on the screen.

Controls

» Control Protection

When this option is checked, Corpse will prevent the accidental reuse of a
control on a course.

Control reuse (of a map exchange for example) permits multi-loop courses to
be planned on a single course. This composite course can then be broken up
into the separate loops (if required) prior to printing.

» Invalid Control Codes

This option provides you with the ability to maintain and use a list of control
identifiers which you do not wish to use, e.g. 1, 2, 3. Ticking the "Warn if
used" to warn you when one of the control identifiers listed here is about to be
used. This is only a warning and you may ignore it if you wish.

New "invalid control codes" may be entered in the edit box provided. Press

<Enter> to have each new code added to the list displayed. To remove a code
from the list, select it then press <CtrI>+<Delete>.
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» XRef
The XRef facility produces a cross reference listing of the controls used in this
event. It will assist in identifying unused controls, control identifier duplication
and the number of controls required for the event.

A listing of the components of the Detailed XRef enables you to tick the items
which you wish to have included in the Detailed XRef listing.

Refer to Screen Components, Menu Bar, XRef for further information.

Corpse Version 6 Page 22



Chapter 5 - Preferences

Use Preferences to control the way in which Corpse generates courses and
control description sheets. These preferences are stored in the CPE file with the
course and control descriptions. This means that different files can have
different preferences. Furthermore, these preferences are in effect if the file is
used on any other computer.

You can save and recall your own preferences using the Save as Defaults and

Load Defaults buttons. These defaults are also used when creating a new CPE
file.

Map Preferences

» Control Symbol Colours

Select the colours used to display the control circles, start triangles, finish
circles and leg lines on the map.

Selected Control - the selected control identifies the control whose
characteristics will be changed by <click>ing on its elements in the status bar
at the bottom of the screen.

Normal Control - controls which are included on this course. This colour is
also used for start triangles, finish circles and leg lines on the map. If the
master map is active, then all controls are normal controls.

Inactive Control - controls which are included in the master control list but
do not form a part of the currently active course.

» Map Text Font
Select the font to be used when placing control numbers on the map. You
may select the font name and size of the font. Features such as bolding and

italics are ignored. Setting a large font size may cause unpredictable results.

Note Use a common font such as “Arial” if it is intended to share files with
other computer users.
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» Hole Size

Select the size (from 1.0 to 9.99 millimetres) at which holes will be placed on
the map for the purposes of breaking leg lines.

» Control Symbol Size

Select the size at which control circles are drawn on the map. A circle size of
6 mm produces a good result.

» Sequence Number Format
Select the format to be used when drawing the sequence numbers on the
map. Selecting 1 will result in consecutive numbers; selecting 1-300 will
cause the control identifier to be printed after the normal sequence number.
» Leg Line Clearance
The leg line clearance is the amount of space left between the control circle
and the end of the leg line when rendering courses on maps. Select the size
of the gap required.

» Control Line Thickness

Select the width (from 0.1 to 0.99 millimetres) at which lines and circles are
drawn on the map. A line thickness of 0.35 mm produces a good result.

IOF Control Descriptions Sheet

» |OF Sheet Line Thickness

Select the width (from 0.1 to 0.99 millimetres) at which lines are drawn when
producing the boxes on IOF control descriptions sheets.

Note IOF control description sheet boxes have been sized at the centre of
the lines which form the boxes. If thick lines are used printing will encroach
into the page margins. If the left page margin is set to zero the vertical box
lines on the left may appear to be half as thick as the other lines. This is
because half the line thickness occurs in an area in which the printer cannot
print.
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» IOF Sheet Lines
All IOF sheet lines are drawn with the “normal” thickness specified above.

Checking “heavy outside line” will cause the outside line of the IOF control
descriptions sheet to be drawn with the “heavy” line thickness specified above.

Checking “heavy third line” will cause the horizontal line after every third
control description of the IOF control descriptions sheet to be drawn with the
“heavy” line thickness specified above.

Check the desired column boxes to produce a "heavy" line after the selected
box or boxes on the IOF control description sheet.

» Control Descriptions Sheet Cell Size
Select the size of the boxes used on the I0OF control descriptions sheet.

» Control Descriptions Sheet Font
Select the font to be used when placing text such as control numbers on the
IOF control descriptions sheets. You may select the font name and size of

the font. Setting a large font size may cause unpredictable results.

Note Use a common font such as “Arial” if it is intended to share files with
other computer users.

» |OF Symbol Pen Width
Corpse renders IOF symbols by drawing straight lines and curves. This option
allows you to select the width of the pen used in the drawing process. Select

a value (from 0.1 to 0.99 millimetres) which provides you with the best result
for the printing process.

English Control Descriptions Sheet

» Sheet Width

Select the width in millimetres available to print English control descriptions
sheets. Setting this number to less than 50 millimetres or setting a large font
size may cause unpredictable results. The minimum value accepted is 30
millimetres.
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» Font

Select the font to be used when placing text on English control descriptions
sheets. You may select the font name and size of the font. Setting a large
font size may cause unpredictable results.

Note Use a common font such as “Arial” if it is intended to share files with
other computer users..

This font is also used for the printing of other English (text) based reports such
as XRef, Control Codes and Punch Patterns, as well as for rendering map
titles.

» Descriptions

You can elect to have Corpse generate English descriptions in long (e.g. north
eastern) or short (e.g. NE) format. To put this option into effect you have to
regenerate the English descriptions.

You can elect to have Corpse generate a new English description for a control
each time the IOF description is changed. If this option is selected, any user-
entered text is automatically replaced by Corpse. If this option is not selected
then a new English description is entered by the processes outlined at Course
Descriptions, Setting English Descriptions in this manual.
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Chapter 6 - Screen Components
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Menu Bar

The menu bar provides access to the following facilities:

File Menu
View Menu
Map Menu
Event Menu
Quick Entry
XRef
Preferences
Utilities Menu
Help Menu

File Menu

The commands on the File menu are:
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New Create a new event file. The file is either new (no courses) or one
of the model events previously defined.

Open Load an existing event file.

Save Save the current project using its current name.

Save As Save the current event using a new name.

Export Creates a text file with much of the information for the current
event. The format of this file is self documenting.

Mail To Generates an E-mail with a copy of the current event file (*.CPE)
attached.

Settings Sets parameters that affect the operation of Corpse, e.g. timed
backups. For more information refer to Settings in this manual.

Models A model is a new event with a selected set of course tabs already
created. This option enables the creation of a new model using the
course tabs defined for this event. No other information is saved,
only the course names.

Print Setup Enable the selection of a printer and the setting of its
characteristics.

Print Initiate printing of the current active file.

Exit Close the open file and exit Corpse.

History List Lists the last five events you have closed.

View Menu

The View Menu permits you to control the way Corpse displays the information
on the screen.

The map provides the working surface on which to place controls. Until a map is
selected, many Corpse functions are not available. The map can be changed at
any time, however, if a smaller map is chosen, already defined controls may no
longer be accessible as they are no longer on the map.

» Map Only

Refer to Screen Components, Tool Bar, Mode Tools.

» Map and IOF

Refer to Screen Components, Tool Bar, Mode Tools.

» Map and English

Refer to Screen Components, Tool Bar, Mode Tools.
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» Cartography
Refer to Screen Components, Tool Bar, Mode Tools.
» Control Focus

When a control is selected, via the Control Descriptions Panel for example,
Corpse will ensure that the control can be seen on the computer's screen by
moving the focus (view window) of the map. This will also occur when
changing view from one course to another. This option can be de-selected to
prevent this refocusing from occurring.

» Runner's View
Selecting this option causes the Runner's View window to be displayed.

» Refresh
Refreshes the display.

» Hide Cartography
Cartographic items take time to draw on the screen. Selecting this option will
prevent Corpse from displaying these objects on the map unless Corpse is in
Cartography mode. Setting this option has no affect on the printed result.

» Hide Control Numbers
Selecting this option will prevent Corpse from displaying control identifiers or
sequence numbers. This meansthatimportant map detail will not be obscured
by these numbers. This can be a problem on the master map which may have
many controls in a confined area.

» Hide Inactive
Selecting this option will prevent Corpse from displaying controls which do not
belong to the course currently being displayed. This means that important

map detail will not be obscured by these controls. However, controls which are
not currently visible can still be added to the current course by <click>ing over

the location of the hidden control with the @l button down.
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» Quick Scroll

When the map image is scrolled using the vertical and horizontal slider bars,
the course is drawn on the newly exposed section of map. This drawing
process may slow down the scrolling process. Selecting this option will
prevent the course from being redrawn until the mouse is released at the end
of the scrolling process.

Note Quick scroll is always selected when in Cartography mode.
» Cross Hairs

When Cross Hairs is selected, Corpse will display a fine line "+" depicting the
centre of the control circle. Cross hairs in conjunction with speed keys can be
used for accurate positioning of control circles.

Map Menu

The map provides the working surface to place controls. Until a map is selected
many Corpse functions are not available. The map can be changed at any time,
however, if a smaller map is chosen, already defined controls may no longer be
accessible as they are no longer on the map.

» Load Map

A dialog box is provided to select a Windows BMP file representing the
orienteering map. The BMP file can be sourced from your scanner or from
OCAD. The software which loads the EPS file is specifically designed for EPS
files generated by OCAD. Refer to Corpse, OCAD and EPS for further
information.

Some BMP files do not have the DPI information recorded in the file. If the
DPI information cannot be found in the map file, a dialog box will appear so
that it can be entered manually. Corpse will compensate for changes in DPI.
This means that for large maps, a file with low resolution can be used for the
preliminary work; this will provide better responsiveness from the computer.
A map with higher resolution can then be used for any necessary fine tuning
in positioning controls or printing of maps.

Warning When the map is loaded, Corpse checks to ensure that any existing

controls still fit on the map and provides you with the opportunity to delete
controls which no longer fit on the map.
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» Map Scale

The map's scale influences the calculation of course lengths. Typical
orienteering map scales being 1:10,000 and 1:15,000. A drop down list of
typical values is provided. Any numeric value can be entered.

Hint Create a two control course on the map's scale bar and compare the
length of the scale bar with the course length calculated by Corpse.

» Stretch

This option permits the courses which have already been entered into Corpse
to be overlayed on a map of a different scale.

Suppose a map of 1:15,000 has been used for course setting and that all
courses except the Blue course are to be printed on a 1:15,000 map; the Blue
course is to be printed on a 1:10,000 map. Prior to printing the Blue course,
Map B Stretch should be used to tell Corpse that the map's scale is to be
changed from 1:1,15000 to 1:10,000. A new BMP or EPS file should also be
loaded to ensure the control locations are correct (the different maps may not
cover the exact same areas or may be positioned differently on the printed
page). Referto Screen Components, Tool Bar, Map Tools, Select to see how
to move all controls in a single action.

It is best to save the Corpse event file to another file before undertaking this
operation to avoid confusion.

» Map Borders

Corpse uses the area defined by the map as a drawing surface for control
circles, lines, control descriptions, etc. In situations where there is insufficient
room on the map, the drawing surface available to Corpse can be extended.

Selecting this option will present a dialog box for you to add borders to the
map. Borders may be altered at any time, Corpse will automatically reposition
control locations etc if the left or top border is changed. However, items for
which you have entered the position from the top left corner of the map are not
moved. These items include the position of the of control descriptions on
printed maps.

The colour used to display the map borders is set with File b Settings »
System. No fill colour is used in the printing process.
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» EPS File Info
This option displays information about the currently selected map file.
» Tailor Map

The tailor map function is provided for altering the colour depth, size and
resolution of a BMP based map. To alter these parameters for an EPS based
map, re-load the EPS file and select the new parameters required.

The BMP file produced by OCAD or a scanner can make the operation of
Corpse quite slow. This may arise from the DPI of the BMP file being too high
or colours in the BMP file being far greater than can be viewed on the screen
of your PC.

This tailor map function presents you with two images of your BMP file. The
left most image is the original while the right most image shows you what will
happen if the changes you have selected are implemented.

You may:

* Reduce the DPI of the map

* Reduce the number of colours in the map (increasing the number of
colours does not have that affect; it simply slows Corpse by using more
memory)

* Remove any white border on the map (crop)

» Select an area (window) of the map which is large enough for the courses
you are setting

A new BMP file with new characteristics can be created and saved. This new
BMP file can be used interchangeably with the BMP file from which it was
created. Corpse automatically compensates for variations in DPI between
files. However, if you crop the map on the left or the top then all controls will
have to be repositioned.

Event Menu
The Event menu can be accessed through Event on the menu bar or by
<click>ing the right mouse button when the cursor is over the course tabs at the

bottom of the screen.

The Event menu provides access to the following functions (which generally apply
to the currently selected course):
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» Event Name

Selecting this function will provide you with a menu to enter the name of the
“orienteering event”. The name of the event is limited to 100 characters. If
the text contains a "|" then a new line will be forced at that position. Care
should be taken such that this name will be printed clearly on the control
descriptions sheets.

» Event Footer

Selecting this function will provide you with a menu to text which will appear
at the bottom of each control descriptions sheet e.g. a safety bearing, or
course closing time. The footer is limited to 100 characters. If the text
contains a "|" then a new line will be forced at that position. Care should be
taken such that this text will be printed clearly on the control descriptions
sheets.

» New Course
Selecting this function will create a new course and provide you with a menu
to enter the name of that course. The name of the course is limited to ten
characters and must be unique. Care should be taken such that this name will
be printed clearly on the control description sheets. Selection of a large font
may result in this name being clipped when control description sheets are
printed.

» Delete Course
Selecting this function will enable you to delete the course currently showing.
The controls used by this course are not affected by deleting the course and
remain in the master control list.
Note The master control list cannot be deleted.

» Rename Course
Selecting this function will enable you to change the name of the currently
selected course according to the same constraints applying when creating the

course.

Note The master control list cannot be renamed.
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» Copy Course

Selecting this function will enable you to copy the control descriptions from
another course to the current course. Any existing information in the current
course will be overwritten. To duplicate a course, create a new course and
then copy the course to be duplicated.

This option is disabled if there are no other courses available.
Note The master control list cannot be copied from or to.

» Explode Relays
This function is available if the current course is a Relay. Selecting this
function will cause the current relay course to be replaced by all of the courses
which make up the relay. It is wise to create a backup copy of your cpe file
before using this function.

» Separate Loops
This function is available if the current course is a Multi-Loop course.
Selecting this function will cause the current course to be replaced by a
separate course for each loop. It is wise to create a backup copy of your CPE
file before using this function.

» Climb
Selecting this function will enable you to enter up to eight characters to
describe the course climb of the currently selected course. To get Corpse to
calculate the course climb from the leg climbs you have entered, use a "#" for
climb in metres or a "%" for climb as a percentage of the course length.
This option is disabled when the master control list is selected.

» Classes
Selecting this function will enable you to enter up to 100 characters to describe
the competitor classes for the currently selected course. If this field is left
blank then this area is omitted from the display or printing of control
description sheets. If the text contains a "|" then a new line will be forced at
that position.

This option is disabled when the master control list is selected.
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» Competitors

Selecting this function will enable you to enter the number of competitors for
the currently selected course.

This option is disabled when the master control list is selected.

» First Sequence Number
Selecting this function will enable you to enter the sequence number of the first
control of a course. This provides the capability to generate multi-loop courses
and still maintain a consecutive sequence of control numbers.
This option is disabled when the master control list is selected.

» Map Markup

The Map Markup facility provides you with control over the way your maps are
prepared for printing. Refer to Map Markup.

» Local Control Sites
If this option is selected, the position of control sequence numbers on the map
are unique to this course. The initial positions will be copied from the positions

specified for the master control map.

If this option is not selected, the position of control sequence numbers on the
map are those specified for the master control map.

This option is disabled when the master control list is selected.

» Display Control IDs
If this option is selected, the numbers displayed on the screen are the control
identification numbers. If not selected the sequence number in the list of
controls is displayed.
This option is only available when the master control list is selected.

» Order Controls
<Click>ing this option will cause the controls in the master control list to be

sorted in order of the control identifier. The order is start, finish, numeric,
alphanumeric and leg bends. Each group is in ascending order.
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This option is only available when the master control list is selected.

Quick Entry

The Quick facility provides you with the ability to create, delete and order courses
using a spreadsheet format. Only the basic information such as course name,
classes, climb and competitors can be added. Fields in the spreadsheet can be
copied using the standard Windows functions of <Ctrl>+<C> and <Ctrl>+<V>.
Data can be entered into a cell by moving to the cell and start typing. If you press
<Enter> the contents of the cell will be selected and you will be ready to edit the
information already in the cell. Press <Enter> to complete the edit operation or
<Esc> to abort the operation.

» Add Course

Use the Quick # Edit menu or <Ctrl>+<Ins> to create a new course. The
course is inserted after the currently selected course.

» Delete Course

Use the Quick ¥ Edit menu or <Ctrl>+<Del> to delete the currently selected
course.

» Move Course

Courses can be moved to a different position in the list by dragging them to a
new position with the mouse. A course can also be moved one position up or
down by using the Quick B Edit menu commands or <Ctrl>+<U> or
<Ctrl>+<D>.

XRef

The XRef facility produces a cross reference listing of the controls used in this
event. It will assist in identifying unused controls, control identifier duplication
and the number of controls required for the event.

It should be noted that the usage of individual controls can also be viewed by
<Click>ing the right mouse button while the mouse is over a control in the map
panel. This will display a list of courses using the particular control.

If the event contains relays, the relays will be "exploded" into their component

courses prior to XRef generating its information. If there is a problem exploding
the courses, XRef will terminate and no information will be generated. Refer to
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Getting Started, Relays for more information.
» Concise

Concise XRef lists course name, course length, number of controls,
competitors and classes in a tabular form.

» Detailed

Information produced by Detailed XRef includes:

» Event statistics (control requirements, unused controls, number of courses
and total number of competitors).

» Course statistics (number of competitors, competitor class, controls on
course, distance to water and, maximum, minimum and average leg
lengths).

» Control utilisation (number of competitors to visit a control and which
courses use the control).

» Leg utilisation (number of competitors to use a path between two particular
controls and which direction they will run).

This information can be copied to your computer's Clipboard by pressing
<Ctrl>+<C>.

Preferences

Refer to Preferences in this manual.
Utilities Menu

The Utilities menu provides access to:
» Off Map

This utility enables the removal of controls which no longer fit within the
bounds of the map. This can occur if the map file is replaced by a smaller file.

» Clear Holes

This utility removes all holes which may have been added to the event file.
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» Clear Cartography

This utility removes all cartographic objects which may have been added to
the event file.

» Clear Checked
This utility removes all of the check marks from the control descriptions.
» Load Punch Patterns

If the Punch Pattern file has been altered, this utility updates the punch
patterns for the controls in this event.

» Sort Courses Ascending

This utility rearranges the course tabs (excluding Master) into ascending
alphabetical order from left to right.

» Sort Courses Descending

This utility rearranges the course tabs (excluding Master) into descending
alphabetical order from left to right.

» Punch Patterns

This utility enables the creation and editing of a punch pattern file. Refer to
Punch Patterns for further information.

» EPS Viewer
Corpse has a facility for viewing EPS files. You can view a base EPS map

and can also overlay course maps onto the base map. Refer to Corpse, OCAD
and EPS for further information.

Help Menu
The Help menu provides access to:
» Contents
This item displays the Help Topics dialog box to enable you to quickly navigate

through specific areas of Help.
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» System Parameters
The system parameters provide information about:

Maximum number of courses - The maximum number of courses (not
including the master control list) which can be managed in a Corpse eventfile.

Maximum number of controls for an event - The maximum number of
control descriptions which can be held in the master control list.

Maximum number of controls per course - The maximum number of control
descriptions which can be held in any course description list (control
descriptions sheet).

Maximum number of map holes - The maximum number of holes which can
be placed over the map for the purpose of ensuring that leg lines do not hide
features on the map.

Map colours - The number of colours possible in your current map.

Map file size - The disk space in kilobytes used by your current map BMP file.
Map DPI - The scan resolution of your current map BMP file.

Map size - The size of your current map (width x breadth) in millimetres.

Screen colours - The number of colours supported by your screen driver and
screen.

Screen resolution - The number of dots in horizontal and vertical direction on
the screen. The resolution is determined by the installed screen driver and is
set by Windows.

Physical memory - The size of the computer's physical memory (RAM) in
megabytes.

Swap file size - The disk space in kilobytes used by Windows to support the
programs currently running.

Available space on drive - The available disk space in kilobytes on the drive
where Corpse is installed.
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» About

Thisitem provides access to program information such as release number and
release date.

» Corpse Home Page

A direct link to the Corpse web page where you can find out more about the
latest version of Corpse.

» Support Request
Commences an e-mail to the writer of Corpse. It includes the Licensee and

product key automatically. Without these pieces of information, support may
not be provided.

Tool Bar

File Management Tools

E5|E'7|EI||

The tools in this group are shortcuts to functions contained on the File menu and
include:

New file
Open file
Save File
Print

Map Tools

OI\ 3~.-| | @l |"'+|

The tools in this group affect the operation of the mouse when it is over the map
panel. These buttons are mutually exclusive with one and only one button being
selected at any one time.

A button is selected by <click>ing it. While the mouse is over the map image,

right clicking will display a pop up menu giving you direct access to some of the
map tools.
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Control

When this button is down the cursor will change to crosshairs with a circle
when it is over the map. The affect from <click>ing while the cursor is over
the map depends on the following:

The master control map is showing. <Click>ing on any area on the map
that does not have a control marked will cause a control to be placed on the
map and an entry added to the master control list. Controls cannot be
placed directly on top of each other.

A course map is showing. <Click>ing on any area on the map that does
not have a control marked will cause a control to be placed on the map and
an entry added to the master control list. <Click>ing on top of an existing
control which is not already part of the current course will cause this control
to be added to the end of the course.

The new control will become the active control.

Controls can be placed with their centres at a distance of one eighth of the
diameter of the control circle. To create close controls, it may be necessary
to create the second control clear of any existing controls and then drag it
into position or move it using keyboard controls.

Select

When this button is down the cursor will change to an arrow when it is over
the map. Four actions are possible in this mode.

Select Control. <Click>ing on top of a control on this course will cause it
to become the active control. The colour of the control on the map will
change to reflect this. The control will be highlighted in the control
descriptions sheet if it is displayed. The control description will be displayed
in the status bar at the bottom of the screen.

Position Control. If the left mouse button is held down while the cursor is
over a control on the current course then that control can be dragged off to
a new location on the map. The drag action is started when the cursor
changes to directional crosshairs. The drag action is stopped when the
mouse button is released. The dragged control will also become the active
control.

Position All Controls. If <Ctrl> is held down before the “position control”
action is started then all controls will be moved.
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Control Usage. The usage of individual controls can be viewed by holding
down the right mouse button while the mouse is over a control in the map
panel. This will display a list of courses using the particular control. The list
disappears when the right mouse button is released.

Cut

When this button is down the cursor will change to a pair of scissors when
it is over the map. Two actions are possible in this mode.

Delete Course Control. <Click>ing on top of a control on this course will
cause it to be removed from the course.

Delete Event Control. Controls can only be removed together if the delete
function is carried out on the master control map. If the control is in use on
any other courses it cannot be deleted unless it is first deleted from the other
courses.

Break

When this button is down the cursor will change to crosshairs with a broken
circle when it is over the map. <Click>ing with the crosshairs on the line of
a control circle will cause a segment of the control circle to appear or
disappear. The double finish circle can also be broken but you must <click>
over an imaginary circle midway between the double circles. Both circles
will be broken.

This feature can be used to prevent control circles from hiding important
features on the map. The control circle has been defined to have 16
segments which can be turned on or off individually. It is possible to turn off
all 16 segments; this will make it difficult to select the control later on.

Holes

When this button is down the cursor will change to crosshairs with a hole
symbol when itis over the map. Any holes which have already been defined
will also become visible.

<Click>ing over the map area will cause a hole to appear at the crosshairs.
Holes can be removed by <CtrI>+<Click>ing with the crosshairs over a hole.
Holes cannot be moved. They must be deleted and redefined. There is no
restriction with the placement of holes. They can be placed directly on top
of each other (causing some confusion when trying to delete a hole) or they
can be overlapped to form an elongated affect.
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Holes should be added when nearing completion of course setting as a large
number of holes may slow down the operation of Corpse. It should be
remembered that holes only affect leg lines; control circles, triangles and
text are not affected by holes.

Window

When this button is down, <click>ing and holding the mouse button down will
start drawing a rectangle on the map. The rectangle will be complete when
the mouse button is released. The rectangle drawn can be resized or
moved as required; the cursor changes to show the possible action when
over the window or the lines which delineate the window.

This rectangle denotes the window of the map which can be printed if
desired. The rectangle disappears when the <Window> button is up and will
reappear the next time it is down.

Print Registration

When this button is down the cursor will change to crosshairs with two "+"
signs. This enables you to identify two printing registration points. These
will aid in ensuring that Corpse course prints are positioned correctly on the
map. Registration points are optional unless courses are being overlayed.

Registration Point 1 - Locate the crosshairs at the desired point, then
<Ctrl>+ <click>. A “+" will appear on the map.

Registration Point 2 - Locate the crosshairs at the desired point, then
<Alt>+ <click>. A “+" will appear on the map.

To redefine either of the registration points, execute the appropriate step
defined above.

To remove the registration points, with both the <Ctrl> and <Alt> button
pressed, <click> the left mouse button anywhere over the map.

Zoom Tools

Blalole]s|

The tools in this group affect the magnification of the map display. The current
magnification is displayed on the status bar at the bottom of the screen.
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Zoom to fit

<Click>ing this button changes the view magnification so that all of the map
is displayed on the screen. A magnification of less than 25% can occur
depending on the size of the map.

Zoom out

Each time this button is <click>ed the map is moved further away. The
current magnification is reduced by 25% of full size. The minimum
magnification is 25%.

Full scale

<Click>ing this button causes the map to be displayed at the size at which
it was scanned (100%).

Zoom in

Each time this button is <click>ed the map is moved closer in. The current
magnification is increased by 25% of full size. No upper limit has been set
on the magnification.

Zoom to Course

<Click>ing this button causes the map to be displayed at the size at which
all controls of the current course will just fit in the map display window.

Mode Tools

The tools in this group affect the display. These buttons are mutually exclusive
with one and only one button being selected at anyone time.

il Map

The screen displays only the map.
IOF

The screen displays the map and the corresponding control descriptions
sheet in IOF symbol notation.
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English

The screen displays the map and the corresponding control descriptions
sheet in English notation.

Cartography
The screen displays the map and a set of cartographic tools. These tools

allow features such as crossings, out of bounds, water drops, etc. to be
placed on the map. Many of the other tools are disabled when in this mode.

Miscellaneous Tools

Auto Number
The auto number tool is only active when the master control list is displayed.

The auto number tool numbers control identifiers in the following way.
Working in the master control list, the first standard control (i.e. not a start
or finish control) is located; the search commences from the currently
selected control. If the control identifier is numeric then all subsequent
standard controls receive a sequential number based on the first standard
control.

Auto Words

The auto words tool generates English descriptions from the IOF descriptors
for the control. The English descriptions for ALL controls will be replaced.
Any personalised editing will have to be re-performed.

Delete Unused Controls

This tool removes any controls which are included in the master control list
but not used in any course descriptions. The listing of these controls can be

viewed with through XRef § Detailed located on the menu bar.

Unused controls can be removed from the master control list using the
normal map tools.

Show All Courses
When this tool is depressed it shows all courses on the current map. This

provides an overview of the utilisation of a control site and the various
arrival and departure legs for a control.
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Show Inactive Controls

When this tool is down inactive controls (i.e. controls not on this course) are
not displayed. The controls are still there and Corpse reacts accordingly.
This mode provides a clear view of surrounding features which might
otherwise be hidden by inactive controls.

Runner’s View

When this tool is down a floating, resizeable window is displayed. The
window contains an image of the map as the runner would probably hold it.
The current control is displayed at the bottom of the window. The next
control is displayed at the top of the window. The map is rotated such that
the leg line is orientated in a south to north direction with north at the top of
the screen.

If the runner is at the last control, the window is black indicating the end of
the course.

The field of vision of the runner can be altered by dragging the sides of the
window left or right. However, the larger the map segment is the more the
processing power that is required to rotate the map. The window may also
be moved to any position on the screen.

When the Runner's View window is displayed it is displayed at its last used
position. Holding down the <Ctrl> button when activating the Runner's View
window will display the window at the top left of the screen. This will enable
the recovery of the window if it fails to appear on screen when it is
supposed to.

Undo

Corpse supports 10 levels of undo to allow changes to be backed out.
When the mouse is placed over the undo button a message is displayed
identifying the nature of the change which will be backed out should the
button be pressed. In backing out the change, Corpse returns itself to the
state it was in just prior to the change which is being backed out.

Map Panel

The map panel displays the map currently loaded. The top bar displays the
name and the scale of the map.
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A new map can be loaded at any time. The scale can also be changed at will.
Changing these can affect course length calculations or result in controls that
cannot be accessed as they do not fit within the bounds of the new map.

The appearance of a clock on the top bar indicates that timed backups of the
event file will be taken.

Control Descriptions Panel

The Control Descriptions Panel, when visible, appears at the right hand side of
the screen. Corpse can be set to display control descriptions in either English or
IOF notation. See Tool Bar, Mode Tools in this manual.

The Control Descriptions Panel shows the control descriptions and the order of
controls on a course.

The order in which controls appear on the control descriptions sheet can be
changed by <click>ing over the control descriptions sheet the control to be
moved and with the mouse button down, dragging it to its new position.
Information on the control descriptions sheet such as course length, distance to
finish control, and control sequence number are all automatically adjusted. The
course is also redrawn on the map showing the control in its new position.

Status Bar

The status bar is located above the course tab set at the bottom of the screen
and contains the following displays:

]Bu:uulder
When control features are being selected, this window will display an English
description of the feature currently under the cursor. In this case a "Boulder"”
control site is being selected.

2

This enables you to add check marks to controls. This is useful when ticking off
controls which have been checked or identifying controls which need special
attention, etc. Check marks are printed on the master control list. Checked
controls are displayed with a grey background in control description sheets.
Checked controls are not reflected in any way in course control descriptions.
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This display shows the complete description (IOF symbols and words) of the
control currently selected on the course show in the map panel. This display is
"live" and is used to establish or change control features. See Course
Descriptions, Setting IOF Descriptions Features later in this manual.

100%

This display shows the current magnification of the map displayed in the map
panel. A new view scale can be selected by <Click>ing the right mouse button
over this display.

B4E6 235

This display shows the current position (X,Y) of the mouse over the map image.
The X and Y values are expressed in millimetres from the top left hand corner
of the map image.

83

This display shows the current leg length in metres. The distance is from the
highlighted control (or leg bend) to the previous control. The previous control
may be the course start. If a distance is displayed for the first control then this is
the pre-start distance.

4.6 km

This display shows the current course length in kilometres. The distance also
includes any pre-start distance.

Course Tabs

i’ \Master jCoursel fCourse? |

The course tabs identify the courses currently defined for this event. Selecting
one of the available tabs will make that course active and display both the
relevant course on the map and control descriptions sheet. The active control
in the status bar will also be changed. The map screen will be scrolled to bring
the active control into view.

When there are more tabs than will fit across the bottom of the screen, two
arrows will appear at the right hand side to scroll the tabs to provide access to
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the tabs not currently visible.

To add or delete courses, or modify information such as course name, use the
Event menu. Alternatively, a right <click> over a tab on the tabs bar will produce
an Event pop up menu. This will allow you to change information for the
currently selected course.

<Click>ing either of the two arrows at the left hand end of the course tabs will
move the currently selected tab one position to the left or right. The Master tab
cannot be moved.

The <Page Up> and <Page Down> keys will allow you to select the tab to the
right or to the left of the currently selected tab.
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Chapter 7 - Map Markup

The Map Markup facility provides you with control over the way your maps are
prepared for printing. You can decide whether maps have IOF or text based
control description sheets on the front of the map, where the descriptions are
positioned and whether they are overprinted or whether the area behind the
control description is blanked out first.

The markup for each course can be based on the markup of the Master map.
For example, if all maps are to have I0F descriptions in the top right hand corner
then these options should be selected for the Master. All of the other courses
should then identify "Use Master". If one or two of the other courses require
something different then turn off the "Use Master" and set the specific
requirements for that course.

When producing EPS files as output, you have the option to specify printing
control descriptions on the back of the map. Corpse produces a new file which
has the same dimensions as the map. This is a blank sheet with the specified
markup. As a result you can have control descriptions printed on both the front
and the back of the map. You may even have IOF on the front and text on the
back.

General

» Overlay Printing

If checked, material is printed on to the map without first clearing the map
image behind.

Front of Map

» Titles

Text - Any printable text up to 50 characters in length. If you include a "|" then
a new line will be forced at this position. If you include "%e" then the current
Event Name will be substituted. If you include "%c" then the current Course
Name will be substituted.

Position - The distance in millimetres (X,Y) from the top left corner of the

map sheet. The default position is 0,0. If the map borders are changed, this
Position will have to be changed to cater for the new borders.
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» Control Descriptions
Type - Choose from one of None, IOF, English descriptions on the map.

Position - The distance in millimetres (X,Y) from the top left corner of the
map sheet. The default position is directly below the position of the titles plus
a vertical gap equal to the Gutter setting in Print Options. Care must be taken
to ensure that the control descriptions to be printed will fit on the printed map.
Furthermore, if the map borders are changed, this Position will have to be
changed to cater for the new borders.

>» Logo

Position - The distance in millimetres (X,Y) from the top left corner of the
map sheet. The default position is directly below the position of the control
descriptions plus a vertical gap equal to the Gutter setting in Print Options.
If the map borders are changed, this Position will have to be changed to cater
for the new borders.

Back of Map

» Control Descriptions
Type - Choose from one of None, IOF, English descriptions on the map.

Position - The distance in millimetres (X,Y) from the top left corner of the
map sheet. The default position is 0,0. Care must be taken to ensure that the
control descriptions to be printed will fit on the printed map back.
Furthermore, if the map borders are changed, this Position will have to be
changed to cater for the new borders.
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Chapter 8 - Course Descriptions

Setting IOF Descriptions

ABCDEFG
[+ [ros| =& F33[ Easternboulder, 3.0/0.5 m, south east side -

» Column A - Control Number

The first control number (its sequence number) on a course defaults to 1.
This can be changed to accommodate multi-loop courses through Event »
First Sequence Number. The second and subsequent control numbers are
automatically generated and cannot be changed independently.

The default position on the map where the number is placed is the centre of
the control circle. The control number position can be altered so as to avoid
confusion with nearby controls or course lines, or such that it does not hide
important map detail.

<Click> and hold over the control sequence number box to activate a flyout
map segment. The map segment will also display arrows indicating the
approach and departure directions of the various courses which use this
control. The position of the control number can be moved anywhere inside
the flyout box. Move the cursor to the desired position and release the mouse
button. The control number will then be automatically repositioned on the
map.

The size of the flyout map segment is controlled through File § Settings.
Warning If the currently active course uses “local control sites” the new
control number position will only apply to the current course. Otherwise, the
new position will apply to this course, the master and all other courses which
do not use “local control sites”. Refer to Screen Components, Menu Bar,
Event Menu in this manual.

» Column B - Control Code

When a control is first placed on the map it is an unnumbered control site. It
can be changed to a start triangle or finish control, or be given a control code.

<Click> and hold over the control code box to activate a flyout menu which
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offers a choice of control types. Move the cursor to the desired control type
and release the mouse button. The control symbol will then be automatically
redrawn on the map to reflect your choice.

The control types available are:

O
O

=C-

Normal control - depicted by a circle on the map.

Taped control - depicted by a circle on the map. This is a normal
control but also indicates that the route from the previous control is
taped. An extra line of text containing “Follow tapes to next control” is
automatically added to the English control descriptions sheet between
the two controls.

Start triangle - depicted by a triangle on the map. On course maps the
triangle is rotated to point in the direction of the next control. On the
master map the triangle is orientated north south.

When the start triangle option is selected, a dialog box will appear to
enter a “pre-start distance” in metres from the start area to the start
triangle. After a pre-start distance is entered, the course length will then
contain this distance.

Map Exchange - depicted by a triangle on the map. On course maps
the triangle is rotated to point in the direction of the next control. On the
master map the triangle is orientated north south. The leg line
approaching this control is dashed to indicate that the route is taped.

Finish control - depicted by a double circle on the map. The approach
to this control is not taped and requires the orienteer to navigate to it.

Taped Finish - depicted by a double circle on the map. The leg line
approaching this control is dashed to indicate that the route is taped.

Funnel Finish - is depicted by a double circle on the map. The
approach to this control is not taped and requires the orienteer to
navigate to the funnel tapes.

Follow tapes - control is depicted on the screen map as a dashed circle.
The dashed circle is not printed on course maps but is printed on the
master map. The course leg from the previous control is dashed
indicating "follow tapes # metres away from the previous control”.

Leg bend - depicted on the screen map as a small circle. The circles
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do not appear on printed maps. Leg bends enable you to change a leg
line from a straight line to one with bends. The bend does not affect the
leg line type (dashed or solid) but does affect the leg length. A number
of leg bends can be placed between any two controls.

=. Mandatory Crossing - depicted on the screen map as a small circle.
The Mandatory Crossing is the same as a Leg Bend with the additional
function that it places a Mandatory Crossing description in the control
description sheet.
If a crossing symbol is required on the map then this is done in
cartography mode.

~— Mandatory Passage - depicted on the screen map as a small circle.

The Mandatory Passage is the same as a Leg Bend with the additional
function that it places a Mandatory Passage description in the control
description sheet.

Control Code

If the normal control symbol or taped control symbol is selected, a dialog box
will appear to enable you to enter a control code. The dialog box provides a
drop down list of control codes already in use. A warning is provided if you
use a control code which is already in use.

Control Identifier E3
alale
|| vl o000
alale
(1] 4 | Cancel |

(Pressing <Ctrl>+<N> will also display this dialog box.)
Punch Pins

When the control code is entered, Corpse will interrogate the file “Corpse.pch”
to see if a punch pattern exists for this control code and will update the punch
pattern in the dialog box. A punch pattern can be entered manually by
<click>ing on the pins in the punch pattern to turn them on or off. Black
indicates a punch pin, while white indicates no pin.
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You may also change the number of pins in a punch by <click>ing the up or
down arrows beside the punch pin editing display. The default number of pins
used when creating a new punch can be set with through File # Settings.
» Column C - Which Feature
To assign a symbol, <click> and hold over the which feature box to activate
a flyout menu which offers a choice of symbols. Move the cursor to the
desired symbol and release the mouse button.
To clear this item, select the blank square on the flyout menu.
» Column D - Control Feature
Refer to the procedure outlined for column C.
» Column E - Appearance
Refer to the procedure outlined for column C.
» Column F - Dimensions/Combination
To assigh a symbol, <click> and hold over the dimensions box to activate a
flyout menu which offers a number of options. Move the cursor to the desired

option and release the mouse button. If a dimension symbol is selected, then
a dialog box will appear to enable you to enter the relevant dimensions.

Dimensions may be entered with a single or no decimal places. This
achieved by checking the upper checkbox for the left dimension and the lower
checkbox for the right dimension (if one exists). The left box is automatically
updated so that you may preview the dimension as you make changes.
To clear column F, select the blank square on the flyout menu.

» Column G - Marker Location

Refer to the procedure outlined for column C.
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» Column H - Other Information
It is possible to enter two symbols in the other information column.

The first or primary symbol is input using the procedure outlined for column
C.

A second symbol can be entered by holding down the <Ctrl> button before

using the procedure outlined for column C. The second symbol cannot exist
if the primary symbol does not exist.

Setting English Descriptions

ABCDEFG
[+ [ros| =& F33[ Easternboulder, 3.0/0.5 m, south east side -

Corpse will provide a guess at a possible English description based on the
symbols used in the IOF notation. To generate this default, double <click> over
the English description on the status bar. To accept this description, press
<Enter>; to discard it, press <Esc>. Alternatively, type your own modifications
(up to 100 characters) and press <Enter> to accept it. If the text includes a “|”
then the following text will start on a new line.

The default description provided for a control corresponding to a marked route
will contain a "#" at the point that a distance would normally appear, for example,
"Follow tapes # metres to finish" . This is to accommodate the fact that this
description describes a leg and not a control position. Whereas the control such
as a finish is fixed, the last legs of different courses start from different controls
thus making the leg length different

The first "#" is replaced automatically by the appropriate leg length when
generating the English description for the course. You can deactivate this
feature by removing all "#" characters from marked route descriptions. Or you
can have your own marked route descriptions which include a "#".

Corpse can produce long English descriptions (e.g. north eastern) or short
descriptions (e.g. NE). To select the description length, refer to Preferences,
English Control Descriptions Sheets in this manual.

Corpse can also produce English descriptions to immediately reflect changes you

have made to the IOF descriptions. Thisfeature is enabled through Preferences
» English Control Descriptions.
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Setting Punch Pattern

Control Identifier E3
alale
|| vl o000
alale
(1] 4 | Cancel |

The punch pattern for a control is entered with the Control Identifier dialog. This
dialog box can be activated by <click>ing over the punch pattern box on the
status bar or pressing <Ctrl>+<N>. The punch pattern can also be entered when
setting the control type to a normal or taped control (refer to Course Descriptions,
Setting IOF Descriptions).

When the control code is entered, Corpse will interrogate the file ““Corpse.pch™
to see if a punch pattern exists for this control code and will update the punch
pattern in the dialog box. A punch pattern can be entered manually by by
<click>ing on the pins in the punch pattern to turn them on or off. Black indicates
a punch pin, while white indicates no pin.

You may also change the number of pinsin a punch by <click>ing the up or down

arrows beside the punch pin editing display. The default number of pins used
when creating a new punch can be set through File b Settings.

Setting Leg Climb

The climb involved in getting to the current control from the previous control is
entered in the Leg Climb box on the status bar.

Corpse will total the individual leg climbs for a particular course and place it in
the control descriptions. It will only add the climbs to get to normal controls and
taped controls and the last control. Any climbs associated with leg bends are
ignored.

If a climb is entered for a control and the control exists on another course(s) and
has the same previous control or leg bend then the climb will be automatically
added to the other course(s). This means that leg climbs need only be entered
once.
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Warning! Always ensure leg climbs are correct before finally printing course
descriptions. This is best done using the on screen XRef or printed XRef
material. Referto Screen Components, Menu Bar, XRef for further information.
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Chapter 9 - Cartography

Overview

Cartography mode has been introduced to permit the addition of supplementary
information to the map. These features are called cartographic objects.

Cartographic objects fall into five categories:

Area Object Enclosed areas which are dangerous or out of bounds

Line Object Lines representing boundaries or forbidden routes

Point Object Single points such as marked crossings, water drops, first
aid, etc.

Text Object A single point which can contain any required text

Graphic Object A single point which can contain any required picture or
graphic

Tools

» Editing Tools

_=| Change Object

This button is activated when an object is selected and when a symbol is
selected which is compatible with the selected object. For example an area
can be changed to another area, but not to a point or line symbol.
<Click>ing this button will cause the currently selected object to be changed
to the new symbol. For example, this allows you to change an out of bounds
area to a dangerous area.

If the object is a Text object, Change Object provides a dialog box to enable
you to change the text of the selected object.

il Delete Object

<Click>ing this button will cause the currently selected object to be deleted.
_..| Edit Object

When this button is down <click>ing over an object will select it for editing.
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The selection process gives priority to point objects.

_[>| Edit Points

When this button is down the individual nodes of an object can be moved or
deleted. New nodes may also be added to area or line cartographic objects.
Refer to following sections on Area Tools, Line Tools, Text Tools, Point Tools
and Rotatable Point Tools.

g' Draw

When this button is down new cartographic objects may be drawn. Refer to
following sections on Area Tools, Line Tools, Text Tools, Point Tools and
Rotatable Point Tools.

» Area Tools

M Out Of Bounds Area - boundary not marked on the ground

ﬂl Out Of Bounds Area - boundary marked continuously on the ground
ﬂl Out Of Bounds Area - boundary marked intermittently on the ground
| Dangerous Area

To add an area object, select the draw tool and the required area tool. Define
the object by <click>ing on the map at adjacent points of the object. When
all points have been defined complete the operation by <click>ing the right
mouse button.

The object can be adjusted by selecting it and dragging the node boxes to
new positions.

New nodes can be added to an object by selecting it then, with the edit points
tool selected, holding down <CtrI>+<Shift> and <click>ing over the edge of
the object in which you wish to add a new node. The new node can then be
dragged to the desired position.

Nodes can be removed from an object by selecting it then, with the edit points
tool selected, holding down <Ctrl> and <click>ing over the node to be deleted.

Area objects which have less than three nodes (corners) are automatically
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deleted.

Area objects cannot be moved. This is achieved by selecting the edit points
tool and dragging the individual nodes to new locations.

» Line Tools

ﬂ Uncrossable Boundary

Line objects are created using the steps outlined for Area objects.

Line objects which have less than two nodes (corners) are automatically
deleted.

Line objects cannot be moved. This is achieved by selecting the edit points
tool and dragging the individual nodes to new locations.

» Text Tools

il Text - Text is rendered using the font used for control numbers on maps.
Colour Text - Text can be any font, colour, style and size.

A text object is placed on the map by <click>ing at the desired point with the
draw tool selected. The text will be centred on that point. A dialog window
will appear to enable you to enter the desired text.

The text can be changed by selecting the object and pressing the Change
object tool. A dialog window will appear to enable you to enter the desired
text.

Text objects can be moved by selecting the edit points tool and dragging the
object to the new location.

Text objects which have no text are automatically deleted.

» Point Tools

El Drinks

il Radio Control
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il Manned Control
il First Aid
il Hash House

A point object is placed on the map by <click>ing at the desired point with the
draw tool selected.

Point objects can be moved by selecting the edit points tool and dragging the
object to a new location.

» Rotatable Point Tools

il Forbidden Route

3¢| Crossing Point

A rotatable object is placed on the map by <click>ing at the desired point. If
the mouse button is held down and dragged off to the side, a line will appear
showing the angle to which the object will be rotated when the mouse button
is released.

Rotatable objects can be dragged to new positions by selecting the edit points
tool and dragging the object to the new location.

Rotatable objects can only be rotated at the time of creation. To change the
rotation, delete the object and create a new one at the desired angle.

» Graphic Tools
| Graphic

A graphics object is placed on the map by <click>ing at the desired point with
the draw tool selected. The graphics object will be centred on that point. A
dialog window will appear to enable you to enter the desired graphics file as
well as to enter its width and height.

The graphics object and its size can be changed by selecting the object and

pressing the Change object tool. A dialog window will appear to enable you
to enter the desired changes.
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Graphics objects can be moved by selecting the edit points tool and dragging
the object to the new location.

Graphics objects which have no graphic or no size are automatically deleted.
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Chapter 10 - Printing

All printing is conducted through the Print Manager menu. You can access this
menu by selecting File ® Print on the menu bar or the [Print] button on the tool
bar.

Printing refers to the production of printed control descriptions sheets, maps, etc.,
as well as the production of EPS files.

Print Control

The Print Manager menu has a number features which control the way in which
the printed product is produced.

» Printer

Use this option to select a printer available to your computer. A dialog box
enables you to select one of the installed Windows printer drivers. <Click>the
Properties button to change the printing options (for instance to print in
landscape mode).

» Copies
A number of copies can be produced by entering a number between 1 and 99
in this edit box. This option only affects the paper printing process. The
number of copies is generated by internally executing the print process the
prescribed number of times. It is far more efficient to use the copies feature
provided by your printer, if one exists.

» Options

<Click> this button to display the Print Options dialog box. Refer to Print
Options in this manual for an explanation of the options available.

» Print
<Click> this button to output the maps, control descriptions sheets, EPS files,

plots or templates selected. If a selection of items has been chosen then a
pick list of items will be displayed before printing takes place.
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» Preview
Preview enables you to view your output prior to printing.
Note Every effort has been made to ensure that the preview feature provides
an exact representation of the printed results. There may be minor variations
as the resolution of the preview material is usually much lower than the
resolution on the printer.

» Selection
Select the range of course maps or control descriptions sheets to be printed.
Current - the course currently displayed on the screen.
All - all courses including the master control list.
Selection - a pick list of all courses will be displayed when the print or
preview process is initiated.  Highlighted courses will be printed.
Select/deselect a course by <click>ing the course name in the pick list.

» Arrangement

Select the arrangement to print the course control descriptions sheets on the
printer page.

One per page - print each course on a separate page.
Many courses per page - print as many courses on each page as is possible.

Multiple copies per page - print each course on a separate page, as many
copies of that course as will fit are printed on each page.

Always use Preview to check the result prior to printing.

Selecting landscape or portrait page layout can affect the number of courses
printed on each page.

This also applies to the font and print margins used. These settings are
changed with the Preferences located on the menu bar.
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Control Descriptions Sheets

» Print Type
Select the type of output required.

Control Descriptions - IOF - print control descriptions sheets in IOF symbol
notation.

Control Descriptions - English - print control descriptions sheets in English.

Maps

Use this option to print maps. The maps which are printed are based on the map
image you have loaded through Map # Load Map. The printed map will have
(at best) the quality of the loaded map. For example, if an EPS file is loaded
with settings of 100 DPI and 256 colours, the printed map will look very pixelated
and the colour of the map will probably be different from the original map. Best
results will be achieved if the map is loaded with the DPI setting of your printer
and colours set to 24 bit colour. The same applies if you have loaded a BMP file.

When using this option Arrangement is deactivated as maps can only be printed
one per page. The map(s) are printed using the options you have selected
through the Options button.

If the map file is large, previewing and printing maps may be slow. Depending

on the speed and storage capacity of your computer it may be practicable to only
print and preview maps individually.

Overlays

This option is used when you want to print courses and control descriptions onto
existing maps, usually with your own printer. It is assumed that all output fits onto
one page. The output can also be shifted and scaled using the Overlay options
you have selected through the Options button.

A suggested process for printing overlays is:

1. Selecttwo registration points which will appear on the map when printed. Add

these points to the map with the EI tool as described at Screen Components,
Tool Bar, Map Tools.
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2. Print an overlay with the registration point offsets set to O;

3. For both registration points, measure the distances between the printed
overlay registration point and the map registration points. Enter these
numbers in the Print Offset boxes provided in Print » Options # Overlays .
Negative offsets will move the printed registration points up and to the left
while positive offsets will move them down and to the right.

4. Print another overlay.

You may need to repeat the adjustment process a humber of times to achieve
the desired result.

Note - Overlays cannot be previewed. Use Print # Maps B Preview if required.

EPS Files

The EPS file is the file that is sent to the print shop for printing. In general, the
EPS file will contain the whole map or the purple colour separation along with the
course and control descriptions sheet information. As it is usually expensive
(time and money) to have the resultant EPS files printed, it is essential that
they be checked prior to heading off to the print shop.

EPS output cannot be previewed. Use Maps B Preview to check the output
before creating the EPS files.

Each course selected in the EPS Files B Print process will create a file named
"course name.eps" in the same directory as the CPE file. Any existing files with
the same name will be automatically overwritten.

When Corpse is asked to create new EPS files during the print process it does
this by firstly copying the base EPS file you have nominated through the Print
» Options B EPS B Background File setting. The course lines and circles, and
any control descriptions sheets, etc. are then overlaid at the end of the copied
EPS file.

Warning Ensure that you have nominated the correct base EPS file as Corpse

has no way of knowing if the EPS file is the same as the BMP/EPS map file used
to create the courses.
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IOF Symbols

Use this option to print a list of IOF symbols with their English translations.

XRef

Use this option to print statistics for the event. Refer to Screen Components,
Menu Bar, XRef in this manual, for further information.

Punch Patterns

This option prints out the Punch Patterns for controls on a course. All courses
are listed.

Control Codes

This option produces a list of course information for all courses in the
orienteering event. The information includes: course name, length, climb,
classes and an ordered list of control codes.
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Chapter 11 - Print Options

General

Use this option to control the way in which Corpse generates printed output and
files. These preferences are stored in the CPE file with the course and control
descriptions. This means that different files can have different preferences.
Furthermore, these preferences are in effect if the file is used on any other
computer.

Choose from:

Page Setup
Map Options
EPS Options
Overlay Options

You can save and recall your own preferences using the Save as Defaults and

Load Defaults buttons. These defaults are also used when creating a new CPE
file.

Page Setup

Select the white space which is to appear in your printout. The printer you have
may have its own margin settings. The areas specified below are applied to the
printable area provided by the printer. The following settings, specified in
millimetres are available:

Top Margin

Bottom Margin

Left Margin

Right Margin

Gutter  White space between control descriptions sheets (at the sides and
at the bottom).

Map Options

» Area

Full map - The whole map is printed.
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Window - The window defined using the button on the tool bar is printed.
» Size

Full size - the map or map window is printed at its original size. If the area
to be printed will not fit on one page it is segmented and printed across
several pages. If segmenting occurs then a 10 millimetre overlap area is
provided.

Fit on page - the map or map window is scaled down so that when printed it
will fit on one page. The map proportions are maintained (ratio of width to
height). No scaling occurs if the map will fit on the page full size.

» |dentifiers

Sequence - Consecutive numbers as in the first column of the control
descriptions sheet are printed near the control circles.

Control - Control identification numbers as in the second column of the
control descriptions sheet are printed near the control circles. This format is
always used for the master map.

» Approach Arrows
The master control map can be printed with approach arrows corresponding
to the entering and leaving leg lines for each course. This may help when

selecting control marker sites in the field. This option is only available for
maps being printed and does not apply to EPS files.

EPS Options

» EPS Colour

Select the colour that is used for all Corpse printing on EPS maps. Reference
should be made to International Orienteering Federation guidelines.

Note! The EPS colour should be set to black if you are working with colour

separations of the map. Refer to Corpse, OCAD and CPE for more
information.
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» Stretch Printed Output

When printing courses onto already printed maps there maybe a less than
perfect alignment of controls with features on the map. This is typically
caused by distortion in the printing process. The Stretch Printed Output
option gives you the capability of compensating for this affect. The courses
produced by Corpse can be altered by +/- 10%.

Note! Ensure that 100% is selected if maps and courses are being printed at
the same time. If 100% is not selected, the courses will not match the map.

» Background File

The EPS file produced by Corpse consists of a background with the course
lines, circles, control descriptions overlayed on that background. The
background may be one of:

Template - This will usually be a file which has been produced by OCAD
which contains a copy of the "map" which you have used with Corpse to
compile your courses. Although you can use a different map, by default,
Corpse will use the "map" file you have loaded using it as the template EPS
file. Refer to Map, Load Map in this manual. The end result is a single EPS
file containing both the original map and the course mark up material (circles,
leg lines, control descriptions) from Corpse.

Pristine B/W - This option is used to create a purple layer EPS file. Corpse
creates a blank sheet and lays the course lines, circles, control descriptions
etc in greys on that sheet. This file would then be used for overlay printing
onto existing maps using offset printing processes. The shades of grey in the
EPS file would control the darkness of the print colour in the offset printing
process.

Pristine Colour - This would be used to create a full colour overlay EPS file.
Corpse creates a blank sheet and lays the course lines, circles, control
descriptions etc on that sheet in full colour. This file would then be used for
full colour digital printing onto existing maps.

Overlay Options

Courses can be overlay printed directly from Corpse on to existing maps.

Select values for print offsets which result in the printed registration points being
printed over the map registration points. A method for determining the offsets
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is described at Printing, Overlays in this manual.
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Chapter 12 - Punch Patterns

Corpse has the capability of producing and using a master list of punch patterns.
Thisinformation is stored in the file “Corpse.pch” and records a punch pattern for
each unique control identification code.

All versions of Corpse have the ability to use the information contained in the
punch file but only Corpse Extended has the facilities to create the file. To share
punch information it is simply a matter of providing a copy of “Corpse.pch” to
other users. The new file must be installed in the same directory as Corpse.exe.
To create or update your punch file use Utilities » Punch Patterns.

» Add a punch code

Press <Ctrl>+<Enter> to display an edit box to enter a new code. Press
<Enter> to complete the operation or <Esc> to abort the operation.

» Alter a punch code
Select the punch code to be altered from the list displayed. Press <Enter> to
display an edit box to enter a new code. Press <Enter> to complete the
operation or <Esc> to abort the operation.

» Delete a punch code

Select the punch code to be deleted from the list displayed. Press <Del> to
delete the code.

» Enter a punch pattern
Select the punch code to be edited from the list displayed. <Click> on the

pins in the punch pattern displayed to turn them on or off. Black indicates a
punch pin, while white indicates no pin.
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Chapter 13- Corpse, OCAD and EPS

Overview

This is a technical note about Corpse, Bitmaps and OCAD. The comments on
OCAD are based on user experience and should be in no way interpreted as
scientific fact or opinions of OCAD. For detailed or current information on OCAD
please refer to OCAD product information.

This material attempts to give a basic insight into the interaction between Corpse
and OCAD. If, as a Corpse user, you are dependant on another party (OCAD
user) for the supply of BMP files or EPS files it is essential that they also be
aware of the information in this chapter.

The Corpse/OCAD Connection

Corpse can work with two file types produced by OCAD; these are the BMP file
and the EPSfile. Corpse assumes that these two files contain exactly the same
map in different formats.

Corpse uses either the BMP file or the EPS file for positioning controls. Corpse
can then superimpose the controls, course descriptions, etc., onto the EPS files
that have been produced by OCAD to produce high quality course maps for the
orienteer. If a combination of BMP and EPS files is to be used, it is essential
that the BMP file and the EPS file are exactly the same. To ensure that this is
the case, produce both the BMP file (use the export function in the file menu of
OCAD) and the EPS file (using the print function of OCAD) at the same time.

Note! It is essential that the print window is set to the map size while in
OCAD and before producing the EPS file.

Bitmaps

» Requirements
The requirement for the Corpse user is to have a bitmap which:

(a) Shows adequate detail. The detail visible on the bitmap is increased by
increasing the DPI (dots per inch) in the bitmap.
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(b) Enables Corpse to operate at a reasonable speed or better. The smaller
the bitmap that Corpse has to deal with the faster it will operate.

As you can see, requirements (a) and (b) are in direct conflict. Increasing the
visible detail (by increasing the DPI of the bitmap) creates a bigger file. The
bigger file slows down Corpse. Where you strike the balance is dependant on
personal choice and compute power at your disposal.

» Colour

The colour quality of the map is not very important and can be sacrificed in
an effort to better meet (a) or (b) above. Although OCAD users probably
operate in 64,000 colour mode or higher, 256 colours is perfectly adequate for
course setting.

If speed is anissue, itis not just enough to create a bitmap at 256 colours (for
example) and then run your computer with a display setting of 16 million
colours. Every time Corpse displays the map, Windows translates the map
back to 16 million colours.

» Detail Versus Speed

The table below should give you some appreciation of the interaction between
colour, DPI and the size of the resultant BMP file.

BMP File Size - Bytes Per Square CM

DPI 100 150 200 250
Colours
16 388 872 1,550 2,422
P56 1,550 3,488 6,200 9,688
54,000 6,200 13,950| 24,800| 38,750
16M 13,950 31,388 55,800] 87,188

For Little Bombay, a map of around 39cm x 44cm, a file of 10mb is required
at 200 DPI and 256 colours. At 200 DPI and 16M colours it is around 90mb.

» Recommendation
For Corpse work, a bitmap of 200 DPI or more gives adequate detail. In
complex granite, the higher the better. It is better to provide a map that has

too much detail than one with too low a DPI. Corpse can reduce the detail
with its “Tailor Map” facility but it cannot create the detail.
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» OCAD

Producing bitmaps (BMP files) via OCAD has a few hidden traps. My
experience is with OCAD 6, the issues could be different for later versions.

When working in OCAD, some mappers use the HATCHED AREA feature.
This displays solid areas as stripes. If you use the export bitmap facility to
produce a BMP file, the BMP file will also have stripes and not solid colours.
Therefore, before producing the BMP file make sure that the HATCHED
AREA feature is not turned on.

You may have noticed by now that OCAD (6) has some internal barrier which
prevents it from producing bitmaps with a higher DPI. | have observed that
this limit is when the resultant BMP file hits a size of around 16mb. On larger
maps (such as Little Bombay) the map has to be cut down and the DPI
reduced to 150 DPI to get any sort of map.

For most computer setups, OCAD produces a bitmap with 16 million colours.
This typically produces a large file with more colours than you can see and
certainly more than is required for course setting.

It is possible to get OCAD to produce a 256 colour bitmap. This permits the
production of a bitmap with around 50% higher resolution before hitting
OCAD’s 16mb barrier. To achieve this, set the screen colours on your
computer to 256 before opening OCAD to produce the BMP file. Screen
colours are set through Windows (Settings/Control Panel/Display) and can be
done without re-booting the computer. You can return the colour setting to its
previous value in the same way.

EPS

EPS Explained

The Encapsulated PostScript (EPS) language file format is an industry standard
format for the exchange of print files. This is the format most commonly used
in the printing of Orienteering maps.

In general terms, OCAD produces maps using a colour palette comprising black,
blue, brown, green, yellow, purple and grey. These colours represent the
features on an orienteering map.

OCAD produces two types of map:
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Colour Map - All colours are printed. This represents the map that you use
when orienteering.

Colour Separations - A map is printed a single colour at a time. If these were
printed on clear film then laying all films on top of each other would produce the
full colour map.

Colour separations are special prints used in the printing industry. Of importance
is that, for example, a purple separation is not purple; it is black. When used in
the print process, the presence of black represents where the printer is to place
ink on the map (the printer must be told the colour of the ink to be used).
Whether the colour is a light or dark shade is signified by the shade of black
(greyness) on the separation. Black signifies to deposit a lot of ink while light
grey signifies to deposit only a thin layer of ink.

On the other hand, the full colour map EPS file has the information for all colours
defined in it. As such, the colours are actually defined as colours. This leads to
the following peculiarity:

(&) If Corpse is being used to superimpose courses onto a colour map file,
you must set the EPS colour to the correct shade of purple.

(b) If Corpse is being used to superimpose courses onto a purple colour
separation, you must set the EPS colour to black. The shade of purple will
be established at the time of printing and by the shade of black which you
specify with Corpse.

OCAD EPS Implementation

The EPS system is an extensive printing process capable of rendering typeset
books, photographs and artwork. At this time, the implementation of EPS by
OCAD requires only part of the full EPS capability.

CORPSE EPS Implementation

Corpse has an EPS interpret function which can interpret EPS files generated by
OCAD and Corpse. Thisinterpreter may or may not be able to successfully read
EPS files created by other packages.

The EPS interpreter has been developed as a separate module of the Corpse
package. Should OCAD change the way it implements the EPS facility, then it
is intended to make available an upgraded EPS interpreter for Corpse without
needing to upgrade Corpse itself.
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The Corpse EPS interpreter has been optimised to process the range of EPS
commands used by OCAD at this time. This allows Corpse to load EPS files
faster. The optimisation capability can be turned off should problems arise with
loading EPS files.

Hint If you have an EPS file which Corpse cannot load with its own interpreter
then you can use a product such as Adobe Photoshop to create a BMP file from
the EPS file.

EPS Advantages

The Corpse user can gain a number of advantages from using EPS files
generated by OCAD:

1. The EPS file is likely to be much smaller than the equivalent BMP file.

2. Corpse can vary the map's detail and colour at load time. These parameters
can be increased or decreased as desired.

3. If courses are to be added to EPS files, the problem of ensuring that the BMP
file used by Corpse and the EPS files to be overprinted match, is virtually
eliminated. An EPS Viewer has been provided with Corpse. This viewer
enables you to view EPS files created by Corpse. It is also capable of
overlaying course files onto a base map file.
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Chapter 14 - Speed Keys

» Course Setting
<Ctrl>+<N>
<Ctrl>+<0O>
<Ctrl>+<S>
<Ctrl>+<+>
<Ctrl>+<->
<Ctrl>+<Delete>
<Ctrl>+<up arrow>
<Ctrl>+<down arrow>
<up arrow>
<down arrow>
<Shift>+<right arrow>
<Shift>+<left arrow>
<Shift>+<up arrow>
<Shift>+<down arrow>
<PgUp>
<PgDn>
<F5>

» Quick Entry
<Enter>
<Ctrl>+<C>
<Ctrl>+<V>
<Ctrl>+<X>

<Ctrl>+<Insert>

<CtrI>+<Delete>
<Ctrl>+<U>

Corpse Version 6

Display the Control Identifier window enabling input
of a control identifier or punch pattern for the
currently selected control.

Display the Open File menu.

Save the current file.

Zoom in.

Zoom oult.

Delete the currently active control.

Move the active control one position closer to the
start of the course.

Move the active control one position closer to the end
of the course.

Change focus to the preceding course control.
Change focus to the next course control.

Shift the active control one pixel to the right on the
map.

Shift the active control one pixel to the left on the
map.

Shift the active control one pixel upwards on the
map.

Shift the active control one pixel downwards on the
map.

Display the course one to the right of the current
course.

Display the course one to the left of the current
course.

Refresh display.

Start editing the current cell.

Copy the current cell.

Paste the current cell.

Cut the current cell.

Insert a new course after the currently selected
course.

Delete the currently selected course.

Move the currently selected course up one position.
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<Ctrl>+<D>

» Punch Management

<Ctrl>+<S>
<Enter>
<Ctrl>+<C>
<Ctrl>+<V>
<Ctrl>+<X>
<Ctrl>+<Insert>

<CtrI>+<Delete>
<Ctrl>+<U>
<Ctrl>+<D>

» XRef
<Ctrl>+<C>

» EPS Viewer

<Ctrl>+<L>
<Ctrl>+<0O>

Corpse Version 6

Move the currently selected course down one
position.

Save the current file.

Start editing the current cell.

Copy the current cell.

Paste the current cell.

Cut the current cell.

Insert a new punch after the currently selected
punch.

Delete the currently selected punch.

Move the currently selected punch up one position.
Move the currently selected punch down one
position.

Copy the XRef data to the clipboard.

Load a new EPS file.
Overlay another EPS file.
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Chapter 15 - Performance Issues

This section identifies factors which will affect the overall performance of Corpse.
Performance in this instance covers the speed of operation as well as the quality
of the results provided by Corpse.

The topics covered are generally restricted to those over which you have some
control and can influence with your current equipment and how you use it.

Poor Print Quality

Shading in IOF control descriptions If your printer has a "dither" option ensure
that it is set to "none" when printing IOF control descriptions. Dither was not
found to have any affect when printing English control descriptions.

Slow Performance

» Large MAP file

Large map files take a long time to load and consume a lot of system
resources to manage. Slowness can be experienced when changing course
views if the computer has limited amounts of memory.

» Map Colours

Best performance is achieved if the number of colours of the map BMP file
is the same as the computer's screen capability. If your map has been
scanned with 16 million colours but your computer screen is configured at 256
colours the computer has to translate from 16 million to 256 every time the
map is refreshed. The map is refreshed frequently, including every time a
control is moved, added or its number changes.

» Screen Colours
If your map has 256 colours, best performance is achieved by setting the
screen colours to 256 while using Corpse. The screen can be temporarily set

to 256 colours through Windows/Settings without having to re-boot the
computer.
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» Preview
The preview option stores a complete page image for each page previewed.
These can take a significant amount of time to generate and may consume
all system resources if a large number of pages are previewed.
When leaving the preview function the system has to reclaim all space used
by the preview function. The system may use all of its energy doing this
reclaim and forget to talk to you. The symptom is a lot of disk activity.
The obvious solution is to only preview what you want to look at. It may be
necessary to preview material in segments which your computer can handle
comfortably.

» Holes and Cartographic Objects
Only add items such as "holes", breaks in control circles and cartographic
objects after the main course planning has been completed. The display of
cartographic objects can be deactivated.

» Excess Objects

Remove unwanted controls, holes and cartographic objects.

Program Failure

» Map Size

If the memory required by Corpse for the internal representation of the map
is too large Corpse can fail due to insufficient physical memory on the
computer. The map storage requirement should be kept to below 60 mb.
Larger map storage is possible on more powerful computers.

» Shortage of Computer Memory

Corpse uses large slabs of computer memory. Corpse will fail if it cannot find
the memory it needs. A memory shortage can be caused by having too many
tasks running in your computer at the same time or if the available memory
is fragmented. The solution is to minimise the number of other programs
running. If the memory has become fragmented you may have to reboot your
computer.
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Detail Missing in Preview

The preview option permits the user to see what the printed result will look like
when it is printed. To conserve computer resources, the preview is generated at
a much lower resolution than your printer. This leads to some lines disappearing
when previewed. It also causes objects in IOF boxes to look as though they are
off to one side or the two circles for the finish to not be concentric.

In extreme circumstances it "may" be possible for the printed result to be
different from the previewed result. This is brought about by scaling of images
between two different sized pages and mathematical rounding in calculations
which may occur during the process.

Looks Different

You may notice that text will wrap differently on different computers; the ability
to fit text into IOF boxes may also vary. If you print course descriptions at 180
DPI, for example, letters in text will typically take up more space on the page
than if it was printed at 360 DPI.

For consistent results, always print with the same DPI setting for the output
printer.
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cartographic object

These are additional markings placed on the map to indicate important locations
for this event. These symbols denote the location of first aid, water drops,
manned controls, safe crossings, out of bounds areas, etc.

control descriptions sheet

A description of controls (sequence numbers, identification numbers, site
characteristics) provided to competitors on a course of an orienteering event.
Control descriptions sheets can be written in English or IOF symbols.

CMYK

Acronym for cyan, magenta, yellow and black; the four colours used in the
standard model in the printing industry. Refers to a method of specifying colour
using CMYK colour values. (K is used for black)

course name
Course name is the descriptive name given to the orienteering course, e.g. RED
1.

CPE
CPE is the file extension used for files created and used by Corpse.

DPI
Quality of a graphics image measured in dots per inch. This applies to scanned
images (or maps) as well as printed documents.

EPS

The Encapsulated PostScript (EPS) language file format is an industry standard
format for the exchange of print files. This is the format most commonly used
in the printing of Orienteering maps.

event name
The descriptive name of the orienteering event printed in the top box of each
course control descriptions sheet.

map
The map is a Windows BMP file which contains an image of the area in which
the orienteering event is to be held. It may be a complete orienteering map or
a segment of an orienteering map.
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OCAD
A commercially available computer aided drawing package for orienteering
maps.
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bend 48, 54, 58

bmp 6, 9-11, 13, 20, 30-32, 39, 66, 67, 74-76, 78, 81, 84

break 17, 42

cartographic object 84

cartography 4, 6, 29, 30, 38, 45, 54, 59

circle 1, 4, 5, 17, 19, 24, 30, 41, 42, 52-54

classes 6, 34, 36, 37, 68

climb 8, 15, 16, 34, 36, 57, 58, 68

clipboard 5, 37, 80

CMYK 84

competitors 6, 15, 16, 35-37, 84

control code 52, 54, 57

control description 1, 3, 8, 11, 14-17, 19, 23-25, 33, 34, 41, 47, 50, 54

course 1-11, 14-19, 21, 23, 26, 28-39, 41-50, 52, 53, 56-58, 65, 67-71, 74-76,
78-84

course name 6, 17, 36, 37, 49, 50, 65, 67, 68, 84

course tabs 5, 21, 28, 32, 38, 48, 49

CPE 4, 9, 10, 19, 20, 23, 28, 34, 67, 69, 70, 84

defaults 23, 52, 69

DPI 6, 10, 11, 13, 30, 32, 39, 66, 74-76, 83, 84

English 3, 5, 25, 26, 28, 45, 47, 51, 53, 56, 57, 66, 68, 81, 84

EPS 3, 5-8, 10, 11, 13, 20, 21, 30-32, 38, 50, 64, 66, 67, 69-71, 74, 76-78, 80,
84

event footer 8, 33

event menu 15, 17, 27, 32, 49, 52

event name 12, 33, 50, 84

exchange 5, 15, 21, 53, 76, 84

export 28, 74, 76

file menu 12, 27, 40, 74, 79

finish 2, 4, 5, 14, 18, 23, 35, 42, 45, 47, 52, 53, 56, 83

funnel 4, 53

help 5, 9, 20, 27, 38, 70

holes 5, 9, 24, 37, 39, 42, 43, 82

IOF 3-5, 7, 16, 24-26, 28, 44, 45, 47, 48, 50-52, 56, 57, 66, 68, 81, 83, 84

leg 3, 6, 8, 14, 18, 23, 24, 34, 35, 37, 39, 43, 46, 48, 53, 54, 56-58, 70, 71

leg bend 48, 54, 58

length 1, 6, 8, 12, 14, 31, 34, 37, 47, 48, 50, 53, 54, 56, 68

loading 2, 13, 78

local control 16, 17, 35

mandatory crossing 54

mandatory passage 54
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map menu 27, 30

map panel 20, 36, 40, 42, 46, 48

master 3, 4, 7, 9, 17-19, 23, 29, 33-36, 38, 39, 41, 42, 45, 47, 49, 50, 52, 53, 65,
70,73

menu bar 12-15, 18, 22, 27, 32, 45, 52, 58, 64, 65, 68

options 6, 15, 20, 50, 51, 55, 64, 66, 67, 69-71

order 35, 36, 38, 47

preferences 4, 23, 27, 37, 56, 57, 65, 69

print 3, 5, 8, 11, 17-19, 24, 25, 28, 40, 43, 51, 64-69, 71, 74, 76, 77, 81, 83, 84

punch pattern 38, 54, 57, 73, 79

registration 5, 43, 66, 67, 71

special 7, 47, 77

start triangle 7, 52, 53

status bar 6, 23, 41, 43, 47, 48, 56, 57

taped 53, 54, 57

tapes 53, 56

template 6, 7, 71

tool bar 18, 19, 28, 29, 31, 40, 47, 64, 67, 70

undo 4, 9, 46

usage 36, 42

utilities 27, 37, 73

XRef 5, 7, 17, 18, 22, 26, 27, 36, 37, 45, 58, 68, 80

zoom 14, 43, 44, 79

zoom tools 14, 43
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